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THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE 
SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND 
RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED 
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL 
RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS. 

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET 
FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE 
INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE 
LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF 
THESE SUPPLIERS ARE PROVIDED “AS IS” WITH ALL FAULTS. BIOMORPHIS SECURITY LIMITED 
AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, 
INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR 
PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE 
PRACTICE. 

IN NO EVENT SHALL BIOMORPHIS SECURITY LIMITED OR ITS SUPPLIERS BE LIABLE FOR ANY 
INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT 
LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR 
INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES. 

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended 
to be actual addresses and phone numbers. Any examples, command display output, network 
topology diagrams, and other figures included in the document are shown for illustrative purposes 
only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and 
coincidental. 
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CH A P T E R  1: Getting Started with CryptoFiler 

What’s New in CryptoFiler 2.0.3 

Feature Description 
SMTP Setting You can now generate once your SMTP settings: Once you are 

connected and enable to send e-mails from one system, you are no 
longer obliged to execute this operation again in a second 
computer. 

• The SMTP settings are automatically transmitted to any 
other system you are connecting with your credentials  

 
Automated key sending All generated keys stored to CryptoFiler in one, can be automatically 

transferred to any other computer using your credentials 

 
Plug-in to Outlook CryptoFiler proposes a plug-in so that information can be parsed: 

from Outlook to CryptoFiler and vice versa 

 
Security selection CryptoFiler proposes a Facility versus Security panel so that the end 

user may choose the level of security of his mailing system. Two 
options are provided, The automated option where the keys are 
automatically transmitted to the any end user and the non-0 
automated where the keys have  

Security selection 
warning 

CryptoFiler offers a warning when the end user decides to choose 
the facility approach of the automated system as shown in Picture A 

 
Picture -A- 

Possibility of changing 
the Security selection 

The end user can always choose to modify this below security 
option, by going to the Edit Menu, and choosing the option Settings, 
as shown in Picture B 
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Picture -B-- 

 

Application Environments 

The application exists for Windows 10, MAC OSX Operating Systems, and through a web 
Interface for any other operating systems environment with a web interface that adapts the 
screens to smartphones and tablets in IOS and Android environment. 
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CH A P T E R  2: First Steps of the Application 

Installation Steps 

The end user who desires to download the CryptoFiler visit the web site in the page downloads   

https://cryptofiler.bio-morphis.com/#downloads and downloads the CryptoFiler application for 

the operating system of his will, as shown in picture -1-. 

 
Picture -1- 

Installing CryptoFiler 

The installation of CryptoFiler can be executed in two operating systems: 

• Windows 10 

• Mac OSX 

  

https://cryptofiler.bio-morphis.com/#downloads
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1. Installing CryptoFiler in Windows 10 

The end user after having downloaded the application, he installs the application.  

An installer will appear to help the end user to install the Application in Windows, as shown in 

Picture -2-  

 
Picture -2- 

In case in the system, a CryptoFiler application exists already, the end user is notified that the 

application exists, and its content will be overwritten. 

In case the end user desires to continue, the following panel will appear, Picture -3- 
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Picture -3- 

The end user has to accept the license agreement and in this case the application will be 

installed. When the applications is installed the end user is notified for its installation.  

2. Installing CryptoFiler in Mac OS X 

The end user after having downloaded the application, he installs the application.  

An installer will appear to help the end user to install the Application in MAC OSX, as shown in 

Picture -4-  
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Picture -4- 

In case in the system, a CryptoFiler application exists already, the end user is notified that the 

application exists, and its content will be overwritten. 

In case the end user desires to continue, the following panel will appear, Picture -5- 

  
Picture -5- 
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C H A P T E R  3: After Installation Actions 

CryptoFiler after installation actions 

Once the CryptoFiler has been installed, the end user will be asked to provide its credentials, 

that is his email account and password. In case the end used does not have any CryptoFiler 

account, he has to sign up so to get one account. 

Picture -6- shows the panel appearing to the end user once he has installed CryptoFiler whilst 

Picture -7- shows the Sign-Up panel. 

 
Picture -6- 
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Picture -7 

Once the end user has filled the Sign-Up procedure, he can sign in with his credentials. 

Note the end user has 10 days trial to decide whether he would like to buy the application or 

not.  

Not also that if the end user checks the check box “Don’t’ ask me for email and password 

anymore”, the end user is no longer notified and access the CryptoFiler by overpassing the 

Sign-In panel. 

In case you would like to buy CryptoFiler, you have to visit CryptoFiler’ s web page: 

https://cryptofiler.bio-morphis.com/login and provide your credentials that is email account 

and password. 

Once you have entered correctly these data, the web site redirects you to your licences page. 

In this page you can see all the licenses you have bought and if you scroll down the web page 

you can buy a new license. 

Picture -8- shows you the top of the page of licenses, whilst Picture -9- shows you the bottom 

of this same page where you can buy a new license 

  

https://cryptofiler.bio-morphis.com/login
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Picture -8- 

 
Picture -9- 

At the left side of the page the end user may find a navigation menu, proposing another web 

page that is billing. 

In this billing page, the end user can see all the licenses the en user has bought for CryptoFiler 

application, as shown in Picture -10- 
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Picture -10- 
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C H A P T E R  4: Using CryptoFiler 

 

CryptoFiler View 

As shown in Picture -11-, when the end user enters in CryptoFiler, he sees the following menu 

proposals: 

• File 

• Edit 

• Key 

• Actions 

 
Picture -11- 

The File Menu 

Under the File Menu, the end user notices 6 sub menus, that is Authorisation, Upgrade, About, 

Revoke saved Credentials, Switch user, and Exit. 

The Authorisation sub menu opens a browser and directs the end user to a web page where 

the user can have access to detailed information concerning him and CryptoFiler, what he has 

paid and has the possibility to extend his access to CryptoFiler for a specific period by paying 

an amount. CryptoFiler accepts two payment methods, PayPal and Stripe. 

The Upgrade sub menu is a possibility to extend the CryptoFiler license to other computers or 

to expand the subscription by extending it to annual. 
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The About sub menu presents data about CryptoFiler and Bio-Morphis Security Limited 

company by opening a browser and redirecting the end user to the appropriate pages. 

The Revoke saved Credentials is when the end user wants to change the status of the checked 

“Don’t’ ask me for email and password anymore” check box. 

The Switch user allows the end user to have stored different email addresses and to change 

these email addresses. 

The Exit sub-menu closes down the application. 

The Edit Menu 

Under the Edit Menu, the end user notices 2 sub menus, that is SMTP settings, and Manage E-

mail addresses. 

The SMTP settings allows the end user to provide his credentials for accessing his email server 

so that the CryptoFiler application to send emails to any receiver. Note that this action is 

required once, because in case the end user connects to his CryptoFiler account through 

another computer, all data stored in his computer are transmitted securely to the new 

computer. 

The Manage Email Addresses menu is where the end user can add a new email address of him. 

The Key Menu 

Under the Key Menu, the end user notices 5 sub menus, that is Archiving or Proprietary 

Transferring key, and Non-Reputable Email key, PGP or S/MIME key pair, Secure Transferring 

key, Send key and Install key. 

The Archiving or Proprietary Transferring key is a symmetric key generation that can be used 

either for archiving data or in case the end user decides to generate his own key for the 

CryptoFiler Proprietary method- 

The Non-Reputable Email key is an asymmetric key pair generation that can be used in case 

the end user decides to generate his own key pair for the CryptoFiler Non-Reputable method. 

The PGP or S/MIME key pair is an asymmetric key pair generation that can be used in case 

the end user decides to use PGP or S/MIME secure email and send his public key to the receiver 

who is going to communicated securely with hum. 

The Secure Transferring key is an asymmetric key pair generation that can be used in case 

the end user decides to generate his own key pair for the CryptoFiler Non-Reputable method. 

The Send key is for sending your keys to a receiver so to start a secure communication channel. 
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The Install key is for installing a received key by a user who has generated this key so to start 

a secure communication channel. Note that this action is not requested in case both the 

exchanging mail user use CryptoFiler application.  

The Actions Menu 

The Actions Menu is a menu that proposes the end user to choose the ciphering method 

appropriate to action he desire to achieve. Under the Actions Menu, the end user notices 2 sub 

menus, that is Archive, and Secure Communicate. 

The Archive sub-menu is for ciphering sensitive information stored inside organisation’s 

electronic perimeter, so to be protected against illicit intrusion of an intruder inside 

organisation’s electronic perimeter. The Archive refers to a symmetric key cryptography.  

The Secure Communicate sub-menu is for ciphering sensitive information that will be 

transmitted from a sender to a receiver. The Secure Communicate refers to a asymmetric key 

pair cryptography, and proposes two second layer sub menus: Emailing and File Transferring. 

The Emailing sub-menu is when the exchange is realised through emailing protocols and 

proposes two third layer sub menus: Cipher and Decipher. 

C H A P T E R  5: Email Client, ciphering and deciphering 
Ciphering 

The Cipher sub menu is when the end user would like to send securely and information to a 

receiver whilst the Decipher sub-menu is when the end user has received a cipher block and 

desires to decipher it to access the clear information. 

When the end user chooses the ciphering sub menu, he is redirected to a panel as shown in 

Picture -12- 
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Picture -12- 

This panel proposes radio buttons so to help the end user to choose the appropriate method 

through which he would like to communicate securely with the receiver. 

The end user has to select, among the radio buttons (S/MIME, PGP, Proprietary and Non-

Reputable), to choose the appropriate way of securing his email. 

Then he writes the text he desires to secure by ciphering, and in case he would like to attach 

a file or a folder to cipher, he checks the appropriate check box. The system is proposing to 

him new generated keys. In case, the end user desire to use other keys, he has to check the 

check box of the key and choose the key he would like to use. 

The he encrypts the massage by clicking on the Encrypt button, as shown in picture -13- 
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Picture -13- 

Once the message is encrypted the end user has two options: 

1. Either to send the message using the CryptoFiler messaging system 

2. Or to Export the message so Microsoft Outlook to send it to the receiver  

In case the end user decides for the first method the end user has to fill the receivers email 

address as well as the subject and click the button Send, as shown in Picture -14-. 
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Picture -14- 

In this case and if the receiver is using the CryptoFiler Encryptor or Deryptor, the system is 

charged to send automatically the keys to the end user. Otherwise, the sender has to send the 

keys to the receiver, and this is the reason why a notification appears as a message box. 

 
Picture -15- 

In this case, a copy of the email is sent to the sender’s box as proof that this message has 

been sent. 

In case the end user prefers to use Microsoft Outlook application to send the message, the 

send user has to click on the Export to Outlook button, as shown in Picture -16- 
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Picture -16- 

In this case, the end user has to write the receiver email and the subject in the new Outlook 

window, and then go back to CryptoFiler and send the key to the receiver, by clicking the 

Send Keys button. This button will open a window where the end user will has to specify the 

receiver’s email address. 

  
Picture -17- 

After the end user has written the Receiver’s Email Address and pushed the button Send, he 

receives a notification that the Keys have been successfully transferred to the receiver. 
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Picture -18- 

In case the end user would like to add an attachment, he has to click on the check box File 

Attach, Select by browsing the file he would like to attach, select the place and the name of 

the ciphered file he would like to create, as shown in Picture -19-. Then he has to click on 

the Encrypt button. 

  
Picture -19- 

Once the text and file have been successfully encrypted, the end user can either adopt the 

CryptoFiler SMTP method to send the e-mail to the receiver or to click the Export to Outlook 

to export these data to be sent through the Outlook application. 
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Picture -20- 

In Case you are using the Outlook plug-in, do not forget to Send the keys to the end user, 

otherwise the receiver won’t be able to decipher your message and attachments. To do so, 

click to the Send Keys button, and write the receiver’s email address, as shown in Picture     

-21-. 

  
Picture -21- 

An identical procedure is followed for ciphering a Folder. 
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Deciphering 

The Decipher sub menu is when the end user would like to decipher an encrypted message 

sent to him so to access the clear information. 

Once, the end user has received a ciphered message, he has two options, so to access to the 

clear information: 

1. Either to use the CryptoFiler Decipher  

2. Or to open the message using the Outlook application and call in the CryptoFiler menu 

the Export to CryptoFiler plug in or Export the Attachment for deciphering the Attached 

file. 

When the end user chooses the Outlook application, and opens the menu CryptoFiler, he 

notices the two options Export to CryptoFiler, and Export Attachment as shown in Picture -22- 

  
Picture -22- 

In case the end user chooses the Export to CryptoFiler, this plug ins calls CryptoFiler 

application. The applications is loading the received keys, this action may take some time, 

depending on the network, especially the first time when all the keys for this user have to be 

downloaded in the machine he is using. 

Picture -20- shows the Outlook application with the cipher bloc message inside and the 

CryptoFiler plug-ins Menu with the two Options Export to CryptoFiler and Export Attachment.  
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Picture -23- 

By Clicking the Export to CryptoFiler button the CryptoFiler application opens containing the 

cipher bloc message as shown in Picture -24- 

  
Picture -24- 

Once the keys are loaded in the computer system, the end user clicks on the button 

Decipher and he receives the clear text as shown in Picture -25- 
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Picture -25- 

In case the receiver receives a ciphered attached document, he has to initially to save the 

ciphered document in a specific folder in his hard disk and the click either in Export 

Attachment in Outlook’s plug-in.. In CryptoFiler menu, he has to select the folder where the 

clear document has to be stored and then click on the decipher button as shown in Picture -

26- .

  
Picture -26- 

A similar procedure is to follow in order to decipher a ciphered file directly using CryptoFiler 

without using the Outlook plug-in. 
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Picture -27- 

In this case the end user has to select the folder location and name of its ciphered file and 

identify the location and the name where the clear file would like to be deposit. Then he 

clicks on the Decrypt button. 

When CryptoFiler has deciphered the file, the end user is notified as shown in Picture -28-. 

  
Picture -28- 

An identical procedure is followed for deciphering a Folder. 
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C H A P T E R  6: Email Web, ciphering and deciphering 
Web Accessing 

CryptoFiler offers you the possibility to access all ciphered messages through a responsive web 

interface that allows you to see all received messages or compose new ciphered messages in 

all type of devices, that is smartphones, tablets or computer screens.  

An end user, in order to access CryptoFiler web interface, has to visit the website 

https://cryptofiler.bio-morphis.com/login and introduce his credentials, email account and 

password. 

As soon as he has entered in his account, he has to click on the email client link, as shown in 

Picture -29- 

  
Picture -29- 

The Inbox  

By clicking in the Email Client, the end user is redirected to his email account, as shown in 

Picture -30- 

  
Picture -30- 

https://cryptofiler.bio-morphis.com/login
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At the left side of the page, the end user can see a navigation menu, allowing him to see the 

Inbox (incoming messages) the Starred (selected important messages) and the Sent 

messages. 

At the right side of the page, the end user may see all messages he has received. All the 

income ciphered messages appear in the inbox, as shown in Picture -31-. 

  
Picture -31- 

Ever message has three icons, a locker, a star and a bin. In case the end user clicks on the 

received email, a pop-up menu appears and show him the ciphered message as it has been 

received, as shown in Picture -32- 

  
Picture -32- 

In case the end user clicks on the locker, CryptoFiler will instantly decipher the ciphered 

message and a pop-up menu will appear and show the ciphered message as clear text, as 

shown in Picture -33- 
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Picture -33- 

In case the end user clicks on the star, the message is stored in the starred messages and in 

case the end user clicks on the bin, the message goes to the trash bin for storage.  

The Starred  

By choosing in the menu the Starred messages, the end user visits the pages of all important 

messages of him, as shown in Picture -34- 

  
Picture -34- 

The Trash  

By choosing in the menu the Trash, the end user visits the deleted messages he has thrown 

in the bin, as shown in Picture -35- 
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Picture -36- 

In or 

 

C H A P T E R  7: Secure File Transferring  
All email systems have a limited weight for attachments. This limit can be varying from 15 to 

50 Mb. CryptoFiler offers the possibility of a secure file transferring application for all 

documents that are heavier. 

In this case, the end user has to use the Secure File Transferring, and choose between Sending 

or receiving a file or a folder. 

Sending 

The Sending sub menu is when the end user would like to send securely a file or a folder to 

a receiver whilst the Receiving sub-menu is when the end user has received a cipher file or 

folder and desires to decipher it to access the clear information. 

When the end user chooses the Sending sub menu, he is redirected to a panel as shown in 

Picture -34-. In this panel, the sender has to write the e-mail address of the receiver. 

He has to choose among the following actions, whether the receives is a trusted entity or 

organisation or non-trusted one. In case the receiver organisation is a trusted one the end 

user has to choose between two features, whether the ciphering is strong AES 256, or weak 

3DES 196. 

In case the receiving organisation is a non-trusted entity, the end user will have to choose 

among the Advanced or Conventional method. The Conventional method is when the receiving 

organisation has a key pair and it has sent his public key to the sending organisation, whilst 

the Advanced or Proprietary method is when the receiving organisation has not generated or 

not send a key pair to the sending organisation. 
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Picture -36- 

The end user is directed to a panel where he has to choose the method and select the file to 

be ciphered as shown Picture -37-  

 
Picture -37- 

The end user chooses the location and the file or folder he would like to send, selects the 

location where the ciphered file or folder has to be placed and he clicks on the button Encrypt. 
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After having encrypted the file of folder the end user clicks on the Send button. When the 

ciphered file or folder is transmitted, the sender receives a massage, as shown in Picture -38-  

 
Picture -38- 

By clicking on the Send the message is sent to the receiver. 

Receiving 

The Receiving sub menu is when the end user would like to access to a file, or a folder 

securely received and desires to decipher it to access it in clear information. In this Panel the 

end user is directed to a panel as shown in Picture -39-. 

He selects the file or folder he would like to decipher, by clicking on Proceed to the selected 

item and through this action, he is directed to a panel, Picture -40-, where he has to select a 

folder and introduce a name that he has to save the file. 

 In case the end user decides to download the file, the files is only downloaded but it remains 

encrypted, but in case the end user clicks on the Download and decipher, the file is stored in 

clear in the selected folder.  

As this action may take some time, the end user receives a notification that the file has been 

successfully decrypted and stored, Picture -41-. 
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Picture -39- 

  
Picture -40- 

  
Picture -41- 
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C H A P T E R  8: Secure Archiving  
At the same time, CryptoFiler offers the possibility of a ciphering sensitive data inside 

organisations electronic perimeter. A user, so to generate ciphered data and store them 

securely in organisation’s electronic perimeter, he has to choose the Archive oprtion as 

shown in Picture -42- 

 
Picture -42- 

Ciphering 

By doing so, the end user opens a panel where he has to choose between two options, 

Cipher and Decipher and once he has chosen the Cipher Option, the end user has to choose 

among three options: 

1. Data Base Field Archiving 

2. File Archiving 

3. Folder Archiving 

as shown in Picture -43- 
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.   

Picture -43- 

In case the end user chooses the Data Base Field Archiving, a panel opens where the end user 

may place a word, or set of words, a phrase or a paragraph, as shown in Picture -44- 

  
Picture -44- 

After having introduced the clear text in the Source Text box, the end user clicks in the Encrypt 

button and ciphers the data. 
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Picture -45- show the encrypted text generation, whilst Picture -46- shows the message of 

Successful encryption. 

 
Picture -45- 

 
Picture -46- 

In case the end user chooses the File Archiving, a panel opens where the end user has to 

provide the location and the file name, as shown in Picture -47- 

In this panel, the end user has to select the location and the name of the file, the type of the 

algorithm he wants to apply, (Strong or Weak) and the location and the name of the 

ciphered file he would like to store. Picture -47- shows how this panel appears. 
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Picture -47- 

When he clicks on the Encrypt button, he is notified when the ciphered file is successfully 

created. 

In case the end user chooses the Folder Archiving, a panel opens where the end user may 

place a word, or set of words, a phrase or a paragraph, as shown in Picture -48- 

In this panel, the end user has to select the location where the ciphered holder has to be 

stored, the type of the algorithm he wants to apply, (Strong or Weak) and the location and 

the name of the ciphered file he would like to store. Picture -46- shows how this panel 

appears. 

By clicking on the Encrypt button, the end user ciphers the Folder and places it in the storing 

folder. When the application has finished this job, the end user is notified by a message 

informing him that the folder has been usefully encrypted 
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Picture -48- 
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Deciphering 

In case the end user chooses the option, Decipher, he is directed to a panel where the end 

user has to choose among three options: 

1. Data Base Field Archiving 

2. File Archiving 

3. Folder Archiving 

In case the end user chooses the Data Base Filed Archiving, he is redirected to a panel where 

he has to enter the ciphered text and then to click on the Decipher button as shown in 

Picture -47-, whilst Picture -48- informs the end user that the text is successfully deciphered. 

  
Picture -47- 

 
Picture -48- 

In case the end user chooses the File Archiving, a panel opens where the end user has to 

provide the location and the file name where the ciphered document is, as shown in Picture -

49- 
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In this panel, the end user has to select the location and the name of the ciphered file, and 

the location and the name of the clear file he would like to be stored. Picture -49- shows how 

this panel appears. By clicking on the Decrypt button, the end user deciphers the File and 

places it in the storing folder under the name he has written. When the application has 

finished this job, the end user is notified by a message informing him that the file has been 

usefully decrypted 

 

  
Picture -49- 

In case the end user chooses the Folder Archiving, a panel opens where the end user may 

place the folder Name, as shown in Picture -50- 

In this panel, the end user has to select the location where the ciphered folder is stored and 

the location of the clear folder to be store. Picture -50- shows how this panel appears. 

By clicking on the Decrypt button, the end user ciphers the Folder and places it in the storing 

folder. When the application has finished this job, the end user is notified by a message 

informing him that the folder has been usefully decrypted. 
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Picture -50- 

 

C H A P T E R  9: Outlook Configuration  
Normally when CryptoFiler is installed in your computer, the system automatically installs 

CryptoFiler plug-in for the Outlook application. 

Picture -51- shows you where CryptoFiler plug-in appears in Outlook software application 
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